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The October meeting of the
Yokosuka Computer Club will be
held 21 October,1988 at 6:15 p.m.
In room 229 of the IMWR
building. The meeting will be
held on the third Friday in
October vice the second Friday
because of scheduling conflict
with the Navy Day Ball. We hope
to see you all at the Navy Day Ball
on the l4th and the YCC meeting
on the 2lst of October.
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Will this be our last newsietier
or will it be the last newsletter |
have the privilege of producing?
Stacy and [ will be setting our
packout date today (21 Oct 88).
Our Mmacs will be on their merry
way to Sandy Eggo before we can
put together another edition. |1
have had a lot of fun over the last
two years off and on as Editor,
Publisher or contributor. [ have
written about the spirit of the
computer community in in
Yokosuka and will miss you all
and my adopted home. It is time

for us to move on to something
new. Look out Chargers,
Charters's, and San Diego, here
we come.

The last meeting of the club
was small but we had fun making
custom deskiops and putting
command key equivalents on our

§® menus. This month we will be

swapping some of those old icons
for new ones. [ for one am going
to get rid of some of those ugly

warning Icons and replace them

® with some new ones from our

Macintosh public domain
library. More on that later.



Scott Strensland has sent

us a neat article on graphic

plotting algorithms. 1 hope to =

be able o Wry out his algorithm
before the packers come and
carry my keyboard away. I
seems as if our friends in the
Mmidway battle group are just a
malil stop away. Thanks for
laking the time, Scott. 1 include
his address here for those of you
who might want to drop him a
line or two.-

ET3 Scott Strensland
OEOZ USS Mmidway CV-4]
FPO SF, CA 96631-2710.

I am sure he will be glad to
expound on this and other
programming projects.

Art Murphy

YCC Momboership Survey

At the last two meetings it was
proposed that 1 include a survey
sheet to allow members to update
their demographic information.
This info will be used to prepare a
membership directory. Pledse
take the time to complete the
survey sheet and mail it or bring
{t with you to the next meeting.

11

Stacy and I headed up to
Kawasaki to check out an
“Authorized Apple Deadler” we
heard about. Readlly we were
going to see Dirty Clint in “The
Dead Pool” at the Cinecetta Grand
E. The Apple logo can be seen
from the KHK Kawasaki platform.
It is open six days a week. Since it
is closed on Mondays don’t go on
Columbus day.

This small shop is decked out
with an impressive array of
hardware and software. There
was the obligatory Mac 11
running color and lots of
windows. There is an SE and a
plus. There were several brand
name hard disks, scanners and
laser printers.

The new Kensington trackball
was on display. I hope the new
one reguires nush' less
maintenance than their original
design.The shelves were stocked
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with a multitude of software

packages. 1 was very inter- | Dont Worry .. ’
ested to see BMUG (Berkeley  [hamie, Be Happy!
Macintosh Users Group)
shareware disks for sale.

These disks are rated as having
the best in public domain utilities
and applications. The shops name
is IPS Computer Shop, it is on the
fourth floor and the phone
number is (03) 245-2604.

Check them out on your way to
a movie at one of Cinecetta’s five
theaters or The Prime’s 15

reasturants.
Art Murphy
Bowling
DEAR | /-
shoes
parking
LIPS eibein
Kaaaaoli L
Hertz parking
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AMIGA AND HARD DRIVES

Ther-a are many wawvys Lo connect 3
hiar-d dizk to the current Amtiozs computer
lim=. Let=s look at the ASDD and the /31000
First. The ASOO hazs the extender b= on
the left =ide while the 81000 has the
extende b= on the right side.
im=tallation iz s=imple. just connect it to
the =ide of the computer and, if
aprlicable. plug in the pousr zuppls. How
w»ord are ==t to =tart the format and
operatimng =wsztems modificationz Lo
recognize the hard disk. Prices for
Extermnal hard drise are rangese Frrom £5750
of WE. A\ look into the Amigz WHorld
Mg aTiree ol Sam o orgder = 200 megabsete
hiard disk with S0S controller and a Baki
sxpansion connector Jdnternal to the units
faor the price of #7235 They alzo offer a
45 measbete wersion for F#1,03535. This i= a
cost of F2ILTS 20 megr and #2422 (45
megr per megabyete with =ome added

featuras.

hiat-d drriwe in sewver-al wasy=s. externally or
imrtermnallts. It 0= zibize to conmect
dif Ferent sizes of drires Lo the AZ200000
Their ar-e S.25 inch and 2.5 inch deive baws
to in=tall a hard disk. Thew sast be
connaected to the SCS controller in one
of the intermnal card =lot=. Althowsh this
iz one of the moszt economical
configuwration=s, it al=s=o takes up waluabls
Floppy disk ditiue baws

The ins=tallation i= more difFficult than
on the ASOO or the AIOOD computer=.
Fitr=t vou must take of ¥ the computer-=
o and pull the Floppy deiss O0F
im=tall=ds from the
bayw wou pick.  Then
in=tall the hard
drrirr=. In=tall the
controller card into
one of the Amiga
cxpanzion =lot=s and
conmect the data
—abl== to the hae-d
drise. How connect
the powsr cable Lo

i The Camputer Rag The Mewsiztter of the Yokosubka Computer Club i

= : Py
el o I T I LTI
i

I NI IO U 5
BHB DI R ORI NI B *
BN NIN NI NN

= T T |

the hard drive and wog
3re r‘ead'_-.-' to rock and
roll

Sinze there are card
slot= in the AZODND we
—an in=tall 2 hard disk
arnd 3 half lenath
controller conmsected
together aszs x hard card ;
hat—d cat-d= will take up one amd = halfd
card =lot= =
=t open up the /2000 ard carefulle
=lide the hard card into 3 =
=zlot.  Some =ws=tem= reguire the
=upply to be connected direct
di-ivve. Hiz iz al=c simple. The hisrdest
part of the wholz pro-cess |0
the internal expansion card slot=s to o
WO PEEInn SEace W=age For current and
future expansion card=s. Hothing will make
wioid pore ancry than boecing a hiah prices
car-d and find out that wour computer has
run ot of card slot=s. So when wow boee
car-d=s think of the wour futiere
configuration neaeds=.

Im the Aaugust i=zue of Amigs Wor-ldg

their are two S0E Hard cards zdusr-tized.
The 20 meg runs for 3745 and the SOneg

F=4 35 and
I " The

=tall=d and they do not take
e roor in the Floppy drive baws, The
price=s hawve been coming dowwn the past
fFe wear-= bt they e =6l mot
compar-able with the IBM haerd card=s. Hers
iz one exanple. The Flashcard 435
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megabyte storagae hard disk with it= BLL
controller card was purchaszed for $3540.
Thi=z eguatezs Lo F11.02 per megabwte.
Thetrs a2 other deals in the B bhard disk
market t-h.at- will lawer the per megabete
price o undse 10 From Jasan b is a2
little hard Lo Find suwch desls, bat
searchimng throgh M::-:aa._m-- oy Can Find
= *Fatr- prrice for the BM hard drive =y=tem
that will your neseds.

Thezz IBM compatible hard dirises and
hard cards o :rf tn- im=talled in the IBM bas
i Fthe @z The only reodiremsnt

1= hauing th-: E-r idasebozrd in=talled arnd
coperating. The har-d disk carn be shared
betweern both opezrating swestem=. With
thiz adueantage vou camn by a2 laras
Ccapacity B hard dries st the price wou

—an aF¥Foed. The sacret h-—-r“‘ = sy
patrtitiom the d-bee into tuo part=s. The
Eridoeoozrd can only access 1323 megabwtes

at ons tine, byt thers iz alsoc the ability
of Formatting wirtual drives bevond the
22 mecs. Yo will mesed more storaos ares
For- the Boiaa swstem Lthan the
EBridostoard swstem. Anioa [:-r—n:s-g —EHME Aare
imheraentty larger mo=tly bhecouse of the
aduanced graphics and other f‘ﬂat LS
the Aniga of fers. it iz not unusual Lo
=2 a3 proaran uses one megabvte, or more,
of ram in bhe amigs.

ORGANIZING A HARD DISK

Let= take 3 guick look st the MS-0035
=w=tem I::Hf---r we wWwork mifh the F‘{mi-.u

CThi= section will hE]F—' the
viba Bave the Bridgeboard an»:i .:.11"| M-:-Dl_lf:
i= nm;: atible hard driser  Just for an

:”"TF"]'—‘~ v will magire that we haose 3 MS-
DE_ ompatibls computer with a3 20
rm=--:uab te hard drive. We also hawe aboat
a dozen programs that are inm mesd of a
bonte om the hard driceel 3tk WaRHIMG:
Formatting wour drive with any Filkes on
the disk will cau=s wou to loze those fFiles
W owou wish to re—FfFornat vowrs hard dis
withoodt lo=ing Files, backup vour bhard disk
befores hand. ¥4%

The frr=t thing we do is format the

di=k u=sing thse "Format C: =" command.
The <= will! maks=s it a swstem di=sk and allow
it o be bootabls upon powst up. Mol iF

we Jam a1l those program disk inbo the
rocot directory the computer will show =
conalomeration of files,  Hhen we tepe
"OIE" the lizt will =esm ke b goes on
Forewsr 3= all the Ffiles will b2 listed.  Thiz
wWill make it wers Sloppw and bhard Lo Find
the file you want Lo us=.  Their iz al=o
the possibilitys of duplicatico file naoss
that writes over a file as=ociated with
othar program=. To awvoid dangosrous
sitwationz like this, the root directory
shaould anly hawve Four files and ans
drm_n_m_ of directories. The four- files
W.SYsS chidden, read only filelr, M0 T
lt.l‘m:i-:l-:-n, tr2ad only Filelr, COMRASHD COM, arned
AFUTOESEC.BAT. There shouwld be a
ditrectory to store IS Files and s
it -—t.x::r:-.-' to =tore Batch fFiles.,  MWe will
nane this -:lir’»:-‘tur s OO and YBATCH!.
As part of sour RUTDEXEC BAT File wou
shoatd hawe *’he Followirrn lime inclhaded:
Fath l:"“ OOz 0-~BRTCH The PATH command
lwf- cod tell Ms-0is which directori
r——h for extermnal commaryds — arter b
st-ches your wotrking directorw.  This line
um altow vour system to execute aree dos
commarnd o batch File in the DOS o BATCH
Jdirectories from anyw directors oo diciue
woy may be ine G i o the O dries o bard
di=st:. The ~DOS informz MS-002 €0 start
sear-ching for the external command in the
o -:hr'-au:t:_-r v that ne=t to the rook
dlr‘En:tHr‘" e gls ERe =" smbo] For thee e oot
ditrzctorwr. The semicolon G =epar-zhe=s
the path argoument=s, and the O STCH
inform=s ME-002 Lo =ear-ch L BATCH
ditrectary on drive O when
prrewious searches Failed to
fimnd the Ffile asked For .
The BATCH directory showld
Fawe all your bBatch Files o
cxaecuyte all you proogram=s. Here
1= an e 31.—1'-‘ batch fFile For
running Lotus 1220

r D ‘~~1':':E:

I|I

ch o= trn-a command o Chsnooimo
Eln--—hxr-'-.-'_ Haain here iz the
oot directorsy symbol andg
then the 122 directors. The
mext lime executes the Lotus
122 proaram. How o create a batch FfileT

S-00% hasz a2 liree editor ook For EDLIN 0
oy MS-00S marnuwal, to hele o werihe
bat=h fil==.

Here iz how me root directory looks

Tk
aKEinATA <DIF>
DRIIERS <DHF
EaTiCH <DIR=
DIESEUTIL <R
FiEsRLLLE :
HEPRO

LiF

MACHILY
EAsY
BHHDOMES

(2]
W

T




FWREITER <R I=EI=2 24 3a

MULTIMET SOHR To10-88  10:04a
WS 2000 LDIR: 223
HPG <OiF >3F
123 ZOiR Srzap

D= SO i ]
1E Filei=s 9212400 bvtes Fr“
Hotice that the root directors only has
directarie=s listed and no Files. Althouwah,
ot lizted here, | do hawe Four hidden
file= in the oot directorw. Thizs t= done
to kesp any computer beginners From
altering or deleting these files. In other
word=. Out of Siaht, Dut of Mind. | have

S-47E

written batch fFiles with the -..amn—- nEmE A=

B e R e e e L ST - when

e EroomlT . SinE O EC TGHIEES Nianses
twps P the the prompt Col, the
HordFerfaect pr“-‘n:u-am iz execiited.

Happy
Holloween

ORGANIZING THE AMIGA
HARD DISK

prter installing the hard di=sk on woure
Aniga. pasw clos=se attention o the
in=strwu-tions thiat come with either wour
controller card or wour hard disk, one hotw
to partition r;d Format the disk. 1t i=
zone what different than the Floppy
drinhss_

Jrvoe formatted, wou are ready Lo
store all those programs and r:l.at.a File or
o that littls bugg»:!‘_ g= o =tart
COESD SO Qi anm g

tx the hard
di=k wou Find that mane icon start shooins
e on o wold Morkbench winedow. Their seem=
to be mo orgsnization o the whole
=cheme. The best thing vou can do is
=tar-t copywing thesse programs into
ditrectories.  Thiz will help reduce the
canfustion and help kesp some assoactated
file= intact. O the Workbernch disk woou
uill Find a dt-awaer called empty. This
dravrer s an empty directors just wattines
to be coped to your hard drive and be
Filled with ones of you prograpis oF Sope
dat =z file=. Sorry, aonly non—protected
oot ams Can be stored on the hard disk

The be=t way to oo asbout s=toring the
impor-tant aecery dasy proarams and Files to
hard disk 1= by using the CLLL First copy
the empty drawer to the hard drive and
remname it to =ome thines that describes it
Likke "blord=" for youwr best

wordprocessor progran. NHow ooy 38 th
File= from the floppy disk to the hard
di=zk u=ing “Copy A1 DF1: o BDO: Nv w-d=t O
if the program comes with an install
Erooram, run b

Mo yois may havee your progcams s1]
=tored on the hard dsl—. bt g a2re
fFimdins that some of these programs are
not Finding importasnt Files that help the
prooran. Their are pans —=asons For
thi=. HMost zpplication softuazre For the
Ariga has it=s cwn Horkbench ang OO Ffiles,
but they are not being accessed by the
=]=1"1g =|+ln‘-a Or the opsrating
2 }uﬁl- i for fh::e File= in th=
pres. Hers is TR At il B T S S o
Wiz H:n—-ru b di=sk into a2 -:hr'::tur-" arnd mams
it "bWorkbernch”. MHow edit woouar soztartup—
Sequence +e1-—- to read the Follo nuvr:-_a-
= HE'I idorkbamch

i

I_|

{ﬁ
A
AL
'3

Er'u:IIF '

s

b_. ru_su, ._:u;.t
az=sian all the
deesices o
the Hard disk
iJl xr‘L tn—-rn l"i
ditr=ctorss
Hrot e
=xampbs = an
the
bz tn—-rn:‘-n i
. ' : o 1.3 disks
arpder- 'E---"'Star‘t-LJF'—"-’—'Z{u'-‘rll:e-hd_ There will
alwas will b2 thos=s proograms that will
me=d a certain file in the s =D Tl =
roother way to gt thinas to work = by
uzing the A=sion in anocther way. For
= anp e

Y==tarm bIF: HODCword=
Thi=z line in my =-startup—segquesnce assiar:e
the MHordFerfect FProoeoran im the Word=
directors on my bard driees o the WE:
dewvice.  Hhen the ptogrsm calls Ffor other
files located with in that deoice, i will
find then,  Some times o will havse Lo be



more Specific with
SWDILUFE 3=sSig
sometimes
dictiomart
to b2 as
separately

When v =tart
workine with Amiga DO
=one thinas can be
confusina. The best
adui=ze i= to kesp
trwimna to o=t thinas
o run by reading the
Aprtioa DS manual and
=speerimentirea.
FREMEMEER TO BaCE UF
HLL YOlR FILES BEFORE
ESFERIMENTING. | hawve lost manye data Files
durimg the wesks it took me to organiz
s haerd disk

O the Workbenches Frodect pull

down window there = a2 progran calied infoo
Thi= program 2 can be u=ed Lo givee ol
intormstion about a particular progcamn oF
File. To gt information abowut tools and
progects, =elect the ican Ffor the tool or
progect, Chey clickima omceh, then choose
imto Frrom the workbernch meria. The
information includes the twepe (prodecth,
tocl, drawsr. o disky of the cbiect
Yo L = wall az various

,
ot
s

[

v
LU 1]
-+ 17

V]

Iy

=
T
wom oy

Meas = = =ize. Yo can also chanoe
the s=tatus of the chiject by =electing
on2 of the gadogests below the word

STARTUZ. An important part of the info
piim3dor is the Defrauit Tool entryw. Here is
where o can change where the program
i= hiding.  Bn exampls s a wordprocsessor
‘i1z =tor-aed with b=z associated icon
arzrated from the program called
Scribble! Thiz icon will hawve ths default
tool lizsted a=:
Oefault Too Sezzsoribbla!

H= before the proogr-am Scribble! would be
in the directory caltied Wordzs on soor
hard disk.  bhen wow click on the File bcon
it will =earch for the Scrikblse! proaram in
the Swe=: The opsrating =w=tem will
rnever find the program and the Follicaana
= will appear on thie meszsaos line.

Error while openina Sy=iscribbhle: 205
Error 205 iz Object not found. 1t i= easy
to Fix thi=s. Charmae the Dzfault Tool on
cach Con info =creen to =omse thing similar
to the Ffaollowires.

O=fault Tool HODDMords-Soribbls!

HNowl when soa chick o the icom, the
prooram wWwill run and list sour
viordprocessor file as i runnirnes on only
fFloppy di=sk=. AR
File that has a
default tool can be
Jdirected to the
ary directory of
vour likina.  In this
WAy wou can haue
amny fFile directed o

g+

bm TR Pl

any prrogram or wutility tool o2 directorse
blhern wou ot to the point of nic
return, gz me a call and w2 can set up a2
time to =mooth out the rough parts
Since | hawe the A20000 | am Familtar with
both ME-D0Z and AmioaD0S apserating
_____ FEemember, ztupid quaestions do
not esxi=t in oy worldl
M work number i= 2
name and muamber where |

send 3 loan
trences bhefors

COHUE residernce will mesed ta
1=
calling.?

Rich

This Rent For Space

| was a 92 pound weakling both mentatte and
rhy=ically £illl bouaoht e First educational
product From SPRIHNGEOSRED. How Fra = Hu:l»:: ,.

| BEFORE |

4+—— Fointed

« —— Glazed
3\

w- Disappointed

-
-

=t e @ T

44— pleak B

SPRINGBOARD

The guaranteed educational softuasre
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Programmers—
corner-

Programming computers can be
fun. Here are some ideas to entice
you to explore programming.
Together we will use each idea
presented to generate
surprisingly intricate
graphic images with
only a few lines of code.
At the heart of the first
program is this
algorithm:

alpha = y - sin (x)
beta = a - x

To develop a
working
program from
this we imagine a flat surface
where up and down is
represented by y, and left and
right by x. As we change the
value of x and y we generate
values of alpha and beta. Here is
how we do that:

for g = 0 to 20 step O.1
for x = 0 to 20 step 0.1

0000
0000
0000
next x
next y

What we have here are two loops,
one Inside the other. The first and
last line of the above describes
how the y loop adds 0.1 to the
value of y each time the loop
repeats. The loop will repeat until

t.he value of y Is 20 as stated ln
the first line of the y loop.
Similarly for the x loop. As you
may have suspected, for each
given value of y, the variable x
loops repeatedly from 0 to 20.
This is the heart
of the program
which is
represented by the
bullets (esee)  Since
» he values of x and g
# are known inside
the loops we can
find the values of
alpha and beta.
Just replace the
bullets (esee) with:

alpha = y - sin(x)

beta = a-x

alpha X

beta y

point = (alpha , beta)
== this is the point line
The point line may need to be
adapted 1o your programming
environment. [t actually draws a
point on your screen. As of yet
the variable a does not have a
value. The variable a determines
the shape of the resulting image.
At first use a = 0.07 and then
after your program is up and
running, feel free 1o experiment
with a’s value. place the
instruction:

= 0.07

at the beginning of your
program. (better yet make it an
interactive variable e@) Our
program will draw an interesting



image using these few lines of
code. If we use a slightly
complicated algorithm a more

startling image can be created,

Try this one out.

alpha = y -
sign(x)*sqrilabs(b*x~-c)]
beta =a-x

The function abs returns the
absolute value of its argument.
Given the value of (b*x-c) is less
than zero, abs makes it positive.
The functien sqri returns the
square reot of its areument. The
function sign returns the sign of
its argument (+/-) depending on X
in this equatien.

As before, we will need to
imagine a flal surface where we
can vary the value of X and y.
Use the same loops as in the first
example. You are free to choose
the values of the variables a, b,
and ¢. Try a=0.4, b=1, and c=0.

Have fun experimenting with
these models. Both of these ideas
cam from the Computer
Recreation column in the
magazine Scientific American. |
have working programs that run
on the Macintosh and will be glad
to give a demo when the IMidway
returns. Drop me a line if you
have questions or if you want to
discuss this further.

Scolt Strensiand

The animal clip art is from the

Best of ULTIME
disk sent 10 me by MacWorld.

Customiza Your Dasktop

In the last two newsletters we
explored ways to make our
operating environment reflect
our selves. We put In command
keys and made our desktiop
pattern become one of our
favorite drawings. In the Imac
SIG meetings after the main YCC
meeting 1 have demonstrated
these techniques, passed out
copies of the shareware 1 used to
manipulate the system files, and
listened to your feedback.

This month I want to share with
you a simple way to make those
drab finder icons a little more a
reflection of the most important
part of an operating system, YOU.

Icons are 32 x 32 pixel bitmap
graphics with a resource fork.
The 1 cons I want to deal with are
the generic Finder Icons such as
the trash can, file folders and
volume icons(disks). These | cons
are really two icons. The icon and
its mask. A mask is what your
Icon changes into when it is
selected. The Icon and its Imask
are a 256 byte resource that can
be found in an Icon list.

In ResEdit an Icon List is
represented as ICN*¥. An Icon is
represented by ICON and is a 128
byte resource used by the system
and applications, usuadlly in dialog
boxes and they can be inserted
into menus. This month [ want
only to deal with Icon List (ICN*).

The YCC Macintosh SIG public
domalin library has disks of Icons
and utilities for creating your
own Icons. Icons are a lot like



commercials.
to tell the whole story with a |\
few bits of information.
Fire up ResEdit and let’s go o
work on a BACKUP COPY of your

favorite system disk.
on your system file until you

File Edit

ResEdit
sHstem box
Finder

Double click

ALR]

ICN#'s from Finder

Vol.S No.49 O0ctolen 1938

T T T e i e e
generic Icon. Open the custom
Icon and change its ID number
and attributes to match the ones
of the generic Icon. Close the Info
window. The change to the
Custom icon has not been
recorded yet. You must close its

COD

DITL
DLO
| FAS]

% Type: ICN¥

FNDI Name:

133

i DhoenROO® |

Owner tgpe

a |

MEN

Owner ID:

§ Res———

Sub 1D:

MODEF

= b

Attributes:

[0 System Heap
[J Purgeable

come to the Finder. Double click
the Finder and scroll down to
ICT#. Open ICTI¥ and you will be
presented with Icons from the
Finder. Select an Icon and Get
Info from the File menu or just
use Control I. Your screen should
look like the one in my example.
Note the ID numilser and which
attributes are checked. Record
this info on paper or in your note
pad DA. Click closed the Info
window. Put your disk with the
Icon you want to replace the

WDEF
[OJLlocked (X Preload

[ Protected

file and answer yes to record the
change. Then open it back up.

Select the Custom Icon and copy
it by Control C or from copy in
the Edit menu. Click 1o make the
generic Icon window the active
window. Paste your Custom Icon
into the Generic window by
Control V or from the Edit menu
paste function.

The generic Icon will disappear
and the Custom Icon will take its
place. The Icons in the window
may rearrange their order. This
Is natural. The change of Icons
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has not been recorded yet.
You must close down and
answer yes the record the
change.

Remember, only use ResEdit on
a BACKUP COPY and test drive
your creation to see if it is com-
patible with your applications.
Hack on .

Art Murphy

Suroay

First Name:

Family Name:

Home Phone:

ibork Phone

Mailing Rddress:

very
Important!

Your name will appear in the
YCC Membership Catalog for
publication unless you sign and

return this form to the Club
secretary.

Sign:
I do not wish my name published.
Print name:

Work Computer:

Home computer:

Advocation:

Membership Survey

Hard drive:

Scanner:

Video Input:

Plotter:

Yolosube Computen Cluk
DMS Box 17

ATIN: Club  Secnetany

FPO Secttle, WA TR262



From F, E.‘};.(’, M. Gazette
(Far East Terminal

Computer
Hobbuyist) October 88

Input/Output
System. The Main ROM
chip which awaits
loading of @ Celswere
bootstrap routines from
disk(MS-DOS) at power
up to prepare itself to run
applications software.
Genuine IBIM1 machines
have the kernal of the
BASIC Interpreter in
ROM, and can be booted to
BASIC without loading a
disk. However to run the
interpreter, the other
half, the program
BASICA, must be loaded
from disk.

%55 M 9876

Come foim the fum
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